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Why Style Matters 

Like every other business, publishing or otherwise, Semper Press has a specific brand 

image we strive to maintain. However, we don’t want to spend a great deal of time on style and 

formatting issues, because this takes away from the far more vital work of delivering solid 

editing, getting great cover art and promoting your work before, during and after release. For this 

reason, we decided a uniform style guide was the best solution to solving these problems before 

they have a chance to get started.  

Style in this guide refers to the overall presentation of a work, including how punctuation 

is used, dialogue and action tags, passive versus active voice and how numbers are to be written 

in various usages, such as dates versus ages. We use a standard style guide to ensure internal 

consistency in the work we put out for public view. 

Format in this guide refers to the physical architecture of the manuscript, including line 

spacing, font and indents. Our format guidelines are intended to aid readability and ensure 

minimize release formatting time for Semper staff. 

Your personal degree of adherence to these standards is the first and biggest indicator of 

how well you follow directions and how seriously you take your writing career. If you don’t care 

enough about your reputation or readers to follow these guidelines, it is not reasonable for us to 

believe you care enough to take direction from editorial staff or assist in the promotion of your 

work later in the process.  

Simply put, if you don’t care, why should we?  

At Semper Press, we want to be very easy and pleasant for authors to work with, but we 

do expect you to meet us halfway. This guide exists for your benefit and that of our staff, so 

neither side has to waste unnecessary time on revisions later. It is imperative that you read it 
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carefully, follow it scrupulously and ask if you have any questions or concerns. Better to feel 

slightly foolish now by asking than deal with a rejection letter that didn’t have to be because you 

didn’t do a part of your due diligence. 

We welcome any and all questions you may have, so please don’t hesitate to ask! 

With this out of the way, let’s move on to a detailed explanation of what your format 

should look like. 

Format 

The format of your work is the first thing we will notice. Because we are exclusively an 

e-publisher, our work must be consistently free of formatting issues that may result in poor 

readability on an e-reader or even cause us to spend unnecessary time fixing your work so that it 

translates properly into the various readers’ proprietary formats. Therefore, the first step in the 

process is to ensure your formatting is immaculate. 

You will notice that this guide is double-spaced, in Times New Roman font, 12-pt type. If 

your manuscript is formatted any other way, it is incorrect and must be fixed. For a manuscript 

that is already written and doesn’t follow this format, you will need to take the following steps. 

1) Highlight the ENTIRE document. 

2) On the “Home” tab in Microsoft Word, the “Font” field is the third from the left. 

Select “Times New Roman” font from the dropdown menu. Right next to this you will notice a 

number. If it says anything other than “12,” make it so it says “12.” Click the B and I buttons 

directly underneath twice to remove any bold or italic formatting from the document. You will 

notice that the entire page shows in bold italic at first, and then when you click these the second 

time the entire page will be in the same format as this guide. 
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3) Now we need to address your paragraphs. Go to the “Paragraph” field, just to the 

right of the “Font” field, and click the arrow at the lower right-hand corner. A pop-up will appear 

that allows you to change your margins, indents and spacing. From top to bottom: 

a. Set your alignment to “Left.” This will orient all your text off the left margin 

of the page. 

b. Set your indentation to “0.5” in the “Left” field using the arrow buttons, or 

you can simply type this in. 

c. Across from the Indentation field you will see a tab labeled “Special.” Click 

the dropdown menu and select “First line.” This will ensure every time you 

press the Enter key, a new paragraph will begin. 

d. Go down to Spacing. Set the “Before” and “After” fields to 0. (The default is 

10. Click the down button twice to get here.) Then notice the field marked 

“Line,” to the right of these fields. Click on this and select “Double.” This will 

automatically double-space your document. 

4) Now that the body of your document is fixed, it’s time to set up your cover page. The 

cover page should include the information listed on the next page: 
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(Your legal name and pen name, if applicable)    Word Count 

Address 

Phone Number 

Email address 

 

Note that all of the above information is single-spaced, so you’ll need to change this in 

the Paragraph field as in #4, except setting the line spacing to “Single.” At the end of your email 

line, press Enter EIGHT (8) times. Once you have done this, press the backspace key to place 

your cursor on the FAR left edge of the page. Then go up to “Paragraph” and click the icon next 

to the one that’s currently highlighted. This is the “Center” icon. Your cursor will jump to the 

middle of the page. Now put in  

 

 

MANUSCRIPT TITLE IN ALL CAPS (Return to double spacing here) 

Legal or Pen Name 

 

Your cover page is now properly formatted. This is important so we can readily find your 

information if we need to contact you urgently about your manuscript. 

Now things become a little more complicated, because you will need to set a section 

break at the end of this page so that your header shows up properly. To do this, go up to the 

“Page Layout” tab two tabs to the right of the “Home” tab and click on it. At the far right of the 

“Page Setup” field, you will see “Breaks” in the top right-hand corner. Click on this and select 

“Next Page” from the dropdown menu. You will notice that the cursor immediately jumps to the 

next page. You now have your section break set, and it’s time to install your header. To do this, 

go to the “Insert” tab to the left of “Page Layout,” and click on the “Page Number” button in the 

“Header & Footer” field. A dropdown menu will appear. Hover over “Top of Page” and a 

sidebar menu will appear. Click on “Plain #3 and a header and footer will automatically appear 

in the document with a page number. Now type in your legal last name and the title of your 

manuscript next to the page number, separated by slashes like so: Wayne/Title/Page #.  
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The page numbering is now completely wrong. To fix this, go to the “Header” tab in the 

“Header & Footer” section. Down at the bottom, you will see a tab that says “Edit Header.” 

Click on this tab and go to “Navigation,” the third field from the left. You will notice the “Link 

to Previous” tab is highlighted. Click this to break the link. Now select “Different First Page” 

and “Different Odd/Even Pages.” Now go back to the “Page Number” field and select “Format 

Page Numbers” at the bottom of the tab, in the same place as the “Edit Header” tab we talked 

about previously. Click the radio button that says “Start at” and then type 1. This will start your 

headers on the actual page 2 of the novel, not page 2 from your cover page. 

Next, you’ll need to go through and fix your chapter headings. There are two steps to 

this.  

1) Always spell out chapter headings (i.e. Chapter One, Chapter Two, etc.).  

2) Click backspace to set the text at the far left margin and then click the “Center” icon 

on the Home tab.  

Finally, any in-chapter changes of POV, setting or scene should be marked with three 

bold asterisks, as follows: 

*** 

If you’ve followed these instructions properly, your manuscript will be correctly 

formatted and ready to go. It sounds like a lot of work, but you can actually set up a template to 

do the exact same thing with a little bit of practice. There are a number of tutorials and premade 

templates you can find online, but doing it this way gives you more control and ensures you’ll be 

in compliance with standard Semper Press formatting at all times. 

Now that the formatting is correct, let’s move on to style. 
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Style 

Style is in a way even more important than formatting, because this is how we ensure 

consistency for our readers and editors alike. We’ve already discussed that chapter numbers 

should be spelled out, but what about other numbers? Is it “ok” or “okay?” How many letters in 

the onomatopoeic expression “Ahh?” This section will answer all these questions for you. 

Numbers 

Years: 365BC, 1996. This applies even in speech. “I was born in 1977,” he said. 

Firearms calibers: .38 Special, .45 ACP, 30-30, etc. even in speech. 

Dates: Write these out. “On the twenty-second of September, you and the defendant were 

seen in the coffee shop across from the bank fifteen minutes before the robbery.” “On September 

twenty-second, I got my new puppy.” 

Punctuation 

Only use single punctuation marks at the end of a sentence, unless you are conveying 

mixed emotions. For example, “What!?” conveys anger or surprise AND interrogation in that 

order, while “What?!” conveys interrogation AND anger or surprise in THAT order. This should 

be used VERY sparingly. 

Quotation marks: Always lead with a double quotation mark, in accordance with 

American standard usage. Use a single quotation mark to set off someone else’s dialogue, 

followed by a double quotation mark for a quote of a quote, and so on. “I don’t know, Your 

Honor. She said, ‘I don’t understand why Eleanor screamed, “No, Tommy, don’t use the gun!” at 

that particular moment.’ I confess I’m confused by that myself.”    
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Commas: Frankly, this webpage says it better than we could, so we’re just going to go 

with that. These are the rules under which we will consider comma usage correct or otherwise. 

http://grammar.ccc.commnet.edu/GRAMMAR/commas.htm 

Italics: Always italicize the names of books, sailing vessels, newspapers and movies. 

Also, use italics to set off internal dialogue or thoughts. In cases where two people are having an 

entirely internal conversation (two telepaths, for example,) italicize both but set off the second or 

more alien speaker’s dialogue with a colon at the beginning and end to differentiate who’s 

speaking for the reader.  

Things to avoid 

“Purple” prose: “He thrust his angry red-headed warrior into her slick love pudding.” 

This is tedious and annoying. Something like “He thrust his cock into her slick pussy.” Keep it 

simple and don’t hide your meaning behind coy phrasing.  

Vagina/penis: This only works in a love/sex scene if one or both of the characters is a 

doctor or nurse. Even then, it should be used VERY sparingly. You should convey a loss of 

control, which means social graces go right out the window. “Put that erect penis in my 

lubricated vagina!” sounds ludicrous in the context of a bedroom scene. “Stick your hard (dick, 

prick, cock) up my (pussy, snatch, slit, cunt)” adds emotion, urgency and realism to the scene. 

NOTE: If you are uncomfortable with a given alternative word for genitalia, find a synonym that 

doesn’t cause you any particular distress. However, “manhood, maleness, femininity, etc.” 

should be used only as a last resort if you’ve exhausted ALL other available options. 

Fuck: This is a perfectly serviceable word when used properly, but if 1/3 of your 

manuscript consists only of variations a la Rocco in The Boondock Saints, it’s likely to be too 

http://grammar.ccc.commnet.edu/GRAMMAR/commas.htm
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much. “Fuck me,” she cries/pants/moans 15,323 times during the book is going to mean serious 

rewriting. 

Dialogue tags: USE THEM SPARINGLY, IF AT ALL. “SAID” IS GENERALLY 

ENOUGH. 

“He leaned in close to her ear. ‘What do you want me to do?’ he said.” We know he’s 

whispering to her. Don’t tell the reader how to read this. It’s unnecessary. However, sometimes a 

little extra emphasis goes a long way. “’What do you want from me?’ she screamed as she sank 

to her knees.” This is a valid usage, but again, do this sparingly. If he/she moans, whispers, hums 

or shrieks more than twice in a chapter, something needs changing. 

Ok or okay? The correct format is “okay.”  

Expressions of pleasure or disgust: When using onomatopoeia, only two doubled letters. 

“Grr, ahh,” etc. 

Final Thoughts 

Thank you for taking the time to read this. We hope you’ve found it useful and 

informative! This guide isn’t going to cover every possible issue that might arise with your 

manuscript, but it will help you sort out about 90% of the most likely issues that may cause 

unnecessary revisions, rewrites or rejections before your manuscript gets to us. Again, if you 

have any questions or are uncertain about anything, we encourage you to contact us. We would 

rather spend ten minutes discussing a potential problem than reject a great manuscript because of 

needless errors. If you use this guide as a quick reference while editing your work, you will find 

the editorial process is much easier for everyone concerned, meaning your book gets out to the 

world that much faster! 


